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PANTONE® Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards.  Consult current PANTONE Publications for accurate color.  

Pantone, Inc. is the copyright owner of color data and/or software which are licensed to user for use only in
combination with PANTONE® HexWare® 2.0.  PANTONE Color Data and/or Software shall not be copied
onto another disk or into memory unless as part of the execution of PANTONE® HexWare® 2.0.

PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc.  All other product names
and trademarks are the property of their respective owners.  Adobe, Illustrator, InDesign and Photoshop are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.  ColorSync, Macintosh and Mac are trademarks of Apple Computer, Inc., registered in the U.S.
and/or other countries.  Microsoft and Windows are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.  QuarkXPress is a trademark of Quark, Inc. and all
applicable affiliated companies, Reg. U.S. Pat & Tm Off., and in many other countries.  Macromedia and
FreeHand are trademarks or registered trademarks of Macromedia Inc. in the United States and/or other
countries.  GretagMacbeth is a registered trademark of Gretag-Macbeth Holding AG. ProfileMaker is a
trademark of LOGO GmbH, a GretagMacbeth Group Company. ITEC™ and ColorBlind™ are trademarks of
Imaging Technologies Corporation.  Monaco and MonacoPROFILER are either registered trademarks or
trademarks of Monoco Systems, Inc.

Any omission of such marks from any product is regretted and is not intended as an infringement on such
trademarks.  

© Pantone, Inc., 2001  All rights reserved.
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Getting Started

Thank you for purchasing PANTONE® HexWare® 2.0.  

If you are a new user, you are on your way to discovering a whole new realm of color
possibilities in six-color process printing and how you can achieve a larger color gamut than
standard four-color process printing. With its specially developed CMYK plus PANTONE
Hexachrome® Orange and PANTONE Hexachrome Green inks, PANTONE Hexachrome is
the standard for high quality, high fidelity printing.

And to those previous HexWare users who purchased the 2.0 upgrade, we believe you’ll be
pleased with the enhanced feature set incorporated into each of the HexWare plug-ins. This
significant upgrade streamlines and strengthens the Hexachrome® workflow. 

Be sure to check our Web site for additional information, updates and product news. Visit
us at www.pantone.com or try our Hexachrome Web site at www.pantone.com/hexachrome.
We sincerely hope you enjoy exploring a whole new world of color!

What is PANTONE HexWare 2.0?

PANTONE HexWare 2.0 is a software plug-in toolset (PANTONE HexVector® for Adobe®

Illustrator® and PANTONE HexImage® for Adobe Photoshop®) used by designers, prepress
specialists and printers who want to work with the large gamut, six-color Hexachrome
process. The toolset lets users easily convert files to Hexachrome, create and edit color
palettes, perform color corrections, soft proof output and separate files in preparation for
printing in the Hexachrome process.

What Is PANTONE HexVector 2.0?

PANTONE HexVector, a plug-in for Illustrator 9.x, is used to convert vector graphics and line
art to Hexachrome. HexVector comes with the PANTONE solid in hexachrome library - solid
PANTONE Colors optimized for the Hexachrome process. Also included are the PANTONE
Hexachrome libraries for coated and uncoated paper. In addition, a Color Mixer lets you
create custom Hexachrome colors. All Hexachrome color palettes that are created may be
saved for future use or can be shared with other HexVector users. When ready, files can be
printed directly from within Illustrator or saved as EPS files for placement in page layout
programs such as QuarkXPress™. HexVector is now fully ICC-aware and includes specially
developed Hexachrome ICC profiles.

What’s New in HexVector 2.0?

• Ability to save and share custom Hexachrome color palettes 

• A selection of Hexachrome output device profiles

• Full ICC profile compatibility

• Ability to soft proof the document

• Ability to maintain spot colors along with the Hexachrome colors
1
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What is PANTONE HexImage 2.0?

PANTONE HexImage is a color correction and separation plug-in for Photoshop 6.x that
converts raster images into Hexachrome, six-color DCS2.0 files. HexImage provides tools
for creating separations, performing color corrections and adjusting and reading ink
densities. Other newly added features include the ability to proof your Hexachrome
separations, as well as a function to convert Hexachrome separated documents back to
RGB. A selection of ICC-compatible Hexachrome output device profiles are provided.

What’s New in HexImage 2.0?

• Image preview window for soft proofing a Hexachrome document

• Save an accurate RGB proof of your Hexachrome separated file

• Ability to color correct Locally or Globally and adjust and read ink

density values 

• Views of the image before and after color corrections are applied

• Newly developed ICC-compatible Hexachrome output profiles

• Supports Photoshop scripting and batch processing capabilities

System Requirements

Windows®

• Adobe Photoshop 6.x

• Adobe Illustrator 9.x

• Intel® Pentium® Processor

• Microsoft® Windows 98, Windows Millennium Edition, Windows 2000

• 96 MB of RAM

• 40 MB of available hard disk space

• Color monitor with 256-color (8-bit) or greater video card

• CD-ROM drive

Macintosh

• Adobe Photoshop 6.x

• Adobe Illustrator 9.x

• Any PowerPC® processor

• Mac OS software versions 8.6 or 9.x

• 96 MB of RAM

• 40 MB of available hard disk space

• Color monitor with 256-color (8-bit) or greater video card

• CD-ROM Drive
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Installing the Software

Make sure that neither Illustrator nor Photoshop are running. Insert the PANTONE HexWare
2.0 CD and the HexWare installer should automatically launch. If it does not, open the
CD and double-click on ‘PANTONE(R) HexWare(R).’ Follow the on-screen instructions to
complete the installation.

Personalizing Your Software

The first time you use either plug-in, you will be greeted by the Demo Notice screen.
HexWare can run in a demo mode for a 15-day trial period. The demo mode of HexWare
is fully functional; however, it will place a watermark on your output. If you have purchased
the software, you will be prompted to ‘Personalize’ which brings up the registration box as
follows:

You can now fill in the ‘Registered To’ and ‘Serial Number’ fields and click ‘OK.’ Both
HexImage and HexVector require unique serial numbers, so please be sure to use the
appropriate one. If you click ‘Cancel,’ HexWare will run in demo mode. If your demo period
has expired, HexWare will not run without registration. 

Obtaining a Serial Number

To purchase a valid serial number in the United States, you may contact Pantone, Inc.
directly as follows:

Worldwide: 201-935-5500

U.S. toll-free 888-PANTONE

U.S. Fax: 201-896-0242

U.S. E-mail: customerservice@pantone.com

3



PANTONE HexWare Quick Start

The following section is a quick reference guide to get you up and running with HexWare.
More in-depth information on the individual plug-ins is located in the appropriate sections in
this manual.  Follow the HexWare installation instructions above prior to attempting to work
with the plug-ins.

PANTONE HexVector

1. Launch Illustrator.

2. Create or open a piece of previously existing artwork and select any command
in the HexVector submenu in the Illustrator Window menu. 

3. Click the Profiles tab and select your source and separation profiles, depending
on the color space of your document. 

4. Click the Libraries tab and select any PANTONE hexachrome or PANTONE
solid in hexachrome colors that you want to use in the document. Click the
‘Make Swatches’ button to add the colors to the Illustrator document swatch list
and begin coloring objects. Another way to add colors is to create your own
custom colors in the Mixer tab and add them to Illustrator clicking the ‘Make
Swatch’ button.

4
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5. Make sure that any user-created Illustrator swatch colors that you want to be
converted to Hexachrome have a ‘Color Type’ of Process and not Spot.  For
more detailed information on this, refer to page 17.

6. Click the ‘Convert All’ button on the Profiles tab. This will tag all objects in your
document for conversion into PANTONE Hexachrome colors. 

7. Click the ‘Make Proof’ button on the Profiles tab. An RGB proof of the
separation is created. 

8. Save the file as an Illustrator EPS using the ‘Export As HexVector’ option from
the File menu. HexVector will perform the conversion to Hexachrome. You’ve
just created and saved your first HexVector separation!

5
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PANTONE HexImage

1. Launch Photoshop.

2. Create or open an RGB, CMYK or L*a*b* image and select the PANTONE
HexImage command from the Automate submenu of the File menu. 

3. Specify the appropriate source profile. If you don’t know the source profile,
we suggest you experiment with the RGB or CMYK profiles supplied with
Photoshop such as Adobe (1998) or sRGB, etc. 

4. In Photoshop Color Settings, set your ‘Color Management Policies’ to ‘Preserve
Embedded Profiles.’

5. Select a Hexachrome Separation Profile for the digital color output device,
proofing device or press you are going to use. If your specific device is not
available as a choice, we recommend that you select the Computer to Plate
Coated Hvy profile. 

6. Specify the Rendering Intent that you want to use. If you are not sure which to
use, we recommend you use perceptual. 

6
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7. Click the ‘Update Preview’ button. This updates the preview with the settings
you just selected. Placing your cursor anywhere in the image will display the
CMYKOG values for the pixels in that portion of the image.

8. Click the ‘Separate’ button. HexImage produces a new document containing
six channels of color information. You’ve just created your first HexImage
separation! 

7
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9. The image that has been created is a multi-channel file with six channels of
color information. You can either edit it within Photoshop with HexImage Color
Correction or save it as a Photoshop DCS2.0 file. Saving it as a DCS2.0 file
allows you to place the image in applications that support DCS2.0 files such as
Adobe Illustrator, Adobe PageMaker® and QuarkXPress.

10. To proof the DCS2.0 Hexachrome file on your monitor, select ‘Proof HexImage
Document’ from the Automate submenu in the File menu. This will merge the
six Hexachrome plates and then convert to RGB. This is necessary because
Photoshop does not support the Hexachrome color space, but does, of course,
support RGB, which encompasses the Hexachrome color gamut.  

8



PANTONE HexVector 2.0

New Menu Items

To begin, we look at the two new menu items added to Illustrator by the HexVector plug-in:

a) ‘Export as HexVector...’ from the File menu. 
This function tags all objects for conversion to Hexachrome in order to create
the actual separations and then saves the file in the HexVector format. The
next dialog box will ask you to save the file as an EPS or AI file. The file can
now be opened in Illustrator or placed in any page layout application that
supports spot colors. Please note that the file must be saved as an EPS in
order to be placed for output. 

If the file is opened in Illustrator without HexVector installed, several new
layers will be created. The bottom layer is an extra non-printing layer, called
‘Saved Art,’ where the last saved pre-separated artwork is saved for further
editing in HexVector. This layer is locked, invisible and non-printing. The rest of
the document contains the Hexachrome separations for output. 

If the file is opened in Illustrator with HexVector installed, the artwork is
restored to its last saved state for editing and the separations are deleted.
This means that the artwork can be edited in Illustrator as if it is the last saved
composite art and the design process can continue unrestricted. Simply select
‘Export As HexVector’ again before going to press to recreate the separations.

b) ‘PANTONE® HexVector®’ menu in the Window menu. This menu contains four
sub-menu items to show or hide the HexVector tabs named: ‘Mixer,’ ‘Profiles,’
‘Libraries’ and ‘Palettes.’ This selection enables you to work with the different
functions of HexVector.

9



HexVector Function Tabs

This section describes the four tabs on the HexVector interface, and the functions of
each button, dropdown list or menu. Later sections will describe workflow issues relating
to each function.

The Mixer Tab
This window allows you to create your own custom Hexachrome colors for your
custom palettes.

Active Palette dropdown list

This dropdown list allows you to select an ‘Active Palette’ from your list of custom
palettes. The ‘Active Palette’ selection indicates which palette will be modified by
changes made on the Mixer or Library tabs. While in the Mixer tab, you are able to
add and delete colors in the selected ‘Active Palette.’ If you have chosen to create
a document palette from the Palettes tab, it will be a selection here, as well. It is
important to note that any additions or deletions to palettes from any of the
PANTONE HexVector windows will be reflected in the ‘Active Palette.’  

Hexachrome CMYKOG color sliders

These sliders enable you to adjust the percentages of CMYKOG Hexachrome
base colors for each user-created custom color in your ‘Active Palette.’ You can
also type numeric values for the mixes in the text boxes to the right of the slider
bars. CMYKOG values for PANTONE Library colors cannot be modified in the

10
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Mixer tab, even if they are added to a custom palette. This can also include the
document palette, if you have created one and it is currently selected as the
‘Active Palette.’

Recommendations for mixing colors

• When mixing colors in Hexachrome, it is most
efficient to use neighboring colors in the color
wheel. 

• If you are creating a yellowish-green color, simply use
yellow and green. Do NOT use cyan as you might have
done in CMYK. 

• Red colors are best mixed with orange and magenta.

• Yellow and magenta can be used to achieve a slightly cooler red. There is
often no reason to use more than two chromatic colors in a color, but when
creating bright orange colors, using both yellow and orange in the mix will
increase the color strength. 

• To get a redder hue, add magenta. 

• To achieve strong blue colors, it is effective to use 100 percent cyan and
about 70 percent magenta.

• Purplish-blue colors can be constructed with even values of cyan and
magenta or slightly more magenta than cyan.

• The PANTONE hexachrome guides
(https://www.pantone.com/ShopPantone/product.asp?ProductID=33 and
the PANTONE solid in hexachrome coated guide
(https://www.pantone.com/ShopPantone/product.asp?ProductID=135 are
excellent reference guides to learn how different color mixes look when
printed in Hexachrome. They will provide you with a good starting point to
creating new mixes.

• In order to have black print as one color PANTONE Hexachrome Black (e.g.,
for text, shadows, strokes, etc.), there are two methods you can use. The first
method is to set the ‘Color Mode’ to Grayscale within Illustrator.  Grayscale
will always convert to PANTONE Hexachrome Black only.  If you use the
color slider for grayscale, the values selected will convert to PANTONE
Hexachrome Black.  The other method to define PANTONE Hexachrome
Black only in RGB is to set the RGB values to 0,0,0, which will map to100%
PANTONE Hexachrome Black only.  If you do not utilize one of these meth-
ods, black colors will print using the specified profiles and use all six
PANTONE Hexachrome base colors.

NOTE: In the case of a CMYK definition of black, HexVector will

convert to C=0, M=0, Y=0, K=100, O=0, G=0.

11
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What NOT to do when mixing colors

• Orange/cyan mixes or green/magenta mixes should not be used together in
a color mix, as orange uses the same screen angle as cyan and green uses
the same screen angle as magenta. 

New Color button

The New Color command allows you to create and name a new color.

Add Color button

The Add Color command adds the selected custom colors to the ‘Active Palette.’

Delete Color button

This button deletes colors from the ‘Active Palette.’ Select a color in the mixed
color list box and click on the ‘Delete Color’ button. It will be deleted from the
mixed color list. 

Make Swatch button

This command adds selected colors to the Illustrator document’s Swatches
palette.

12



The Profiles Tab
This window enables you to use ICC-based color management in order to properly color
manage the Hexachrome separation process. It is where you will set your source and
separation profiles, which HexVector will use to create six-color separations and render 
a proof. 

Match CMYK Colors to Hexachrome checkbox

This feature is used with CMYK objects only. When checked, this will enable you
to select a CMYK source profile for your object. HexVector will map the object
using this profile, and then remap the CMYK data to the Hexachrome color space,
using the ‘Separation Profile.’ If this box remains unchecked, HexVector will
perform a linear conversion for the CMYK primaries; therefore the current CMYK
values will map to Hexachrome CMYK values on a one-to-one relationship. For
example, 50% cyan would convert to 50% PANTONE Hexachrome Cyan and
PANTONE Hexachrome Orange and PANTONE Hexachrome Green would be
automatically set to zero.

Embed Source Profile checkbox

This feature provides you with the option of embedding the selected source
profile (CMYK or RGB) from the Profiles tab into the exported HexVector
document. When checked (this is the default setting), the working space can be
maintained throughout the workflow for color consistency and Illustrator properly
displays the proof layer. 

13
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Source Profile dropdown lists

These dropdown lists allow you to select a source profile to use with the objects.
The source profile is a description of the color space of the objects you want to
separate. HexVector will remap the objects from this profile during the separation
process.  

Typically the "source" is a scanner or a monitor RGB profile. The profile acts as a
filter so that the binary data in the image gets translated by the Color
Management System (CMS) into calibrated color data.

NOTE: To take full advantage of Hexachrome and achieve a far greater

color gamut than CMYK, we recommend that you maintain an RGB

workflow.

The source profile you select depends on the objects you are going to separate. If
you want to reproduce the objects as they look on the monitor, you should use an
ICC profile for your monitor as the source profile. Generally you want to maintain
the same color space as you use in your Photoshop images. We recommend that
you become familiar with the different working spaces because they all have their
own unique characteristics. If you are unsure which source profile to select, a
good RGB profile to start with is Adobe (1998), which is installed with Photoshop.

CMYK Source Profile

This lists the available CMYK device profiles. On the Macintosh, it is looking for
the profiles in the ColorSync Profiles folder. Windows installed profiles for
Windows 98/ME are located in the Windows\System\Color folder on and for
Windows 2000 in the Windows\System32\spool\drivers\color folder.

RGB Source Profile

This lists the available RGB input device profiles (e.g., scanner and digital
cameras) as well as all monitor profiles available. On the Macintosh, it is looking
for the profiles in the ColorSync Profiles folder. Windows installed profiles for
Windows 98/ME are located in the Windows\System\Color folder on and for
Windows 2000 in the Windows\System32\spool\drivers\color folder.

Separation Profile

This allows you to select a Hexachrome profile to use for the separation process.
The Hexachrome profile is a description of the color space of your output device,
proofing device or printing press. During the separation, the objects will remap to
your source profile, and then separate to Hexachrome using this profile.

Separation profiles (also known as output or destination profiles) typically contain
the color output characteristics of a specific combination of printing device,
rip/driver, screening, ink set, dot gain and substrate. HexVector is developed to be
able to use a Hexachrome profile. The Hexachrome profile is used to create a six-
channel separation by accessing the calibrated color data that was previously
processed through the source profile.  
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The following profiles are installed on your system with HexWare: 

Offset Lithographic Profiles

OffsetPositive Gloss Hvy
OffsetPositive Matte Hvy
OffsetNegative Coated Hvy
OffsetNegative Uncoated Hvy
CTP Coated Hvy
CTP Uncoated Hvy

Proofing Systems

Fuji Color Art Hvy
Imation Matchprint Hvy
Polaroid PolaProof Hvy
DuPont Waterproof CV Hvy
Kodak Approval XP-4 Hvy

Inkjet

Roland Hi-Fi JET PRO
Roland Hi-Fi JET
DuPontAX-4 Chromalin Hvy

Other

Flexo Narrow Web Lgt

A further description of the technical specifications for each of these profiles is
available in Appendix A.

Make Proof button

The Make Proof button becomes active once you select ‘Convert All’.  This feature
builds a proof layer, which the first time is named ‘Proof Layer 1.’  It provides an
RGB proof of the Hexachrome document and is a non-printing layer, which can
be saved, renamed or deleted at any time. Additionally, you can make adjustments
to the document and reinvoke the feature to produce ‘Proof Layer 2,’ ‘Proof Layer
3,’ etc. Doing so enables you to create multiple proofs using different profile
settings, and then turn them on and off to compare the results against each other.
In this way, you can continually view different iterations of the Hexachrome
document prior to final saving.

TIP: You should make a note of which profiles and color palettes were used

for each proof, so that you can either revert to those settings and embed

the profile or manually save different versions of the document and choose

which version to use based on which proof you like best. Remember we can

embed the profiles so you don’t have to write them down.
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Convert All button

This command converts RGB, CMYK and grayscale colors to Hexachrome colors
(i.e., makes the document a HexVector document).  

When you click ‘Convert All,’ all non-Hexachrome colors that are used in the
document are converted to their equivalent Hexachrome color values, excluding
non-PANTONE Spot Colors. Refer to the Chart on the following page for more
detail.  All of these colors are then added to the Illustrator document swatch list.
The same operation is performed when you choose ‘Export As HexVector’ and
‘Make Document Palette.’ ‘Convert All’ has the added benefit of updating the
preview of the document.

NOTE: ‘Convert All,’ ‘Make Document Palette,’ and ‘Export As HexVector’

all convert the document to Hexachrome; therefore, ‘Convert All’ is not

required before ‘Make Document Palette’ or ‘Export As HexVector.’

Separation Setup and printing in non-composite mode only require that the

document has either been converted or saved as HexVector at least once.

Afterward they will operate properly without needing ‘Convert All’ again.

This enables you to print or separate traditional, non-Hexachrome

documents as well.
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How Colors are Converted to Hexachrome

This table provides a summary of the process and rules by which colors are converted to
their Hexachrome equivalent color values when you have clicked the ‘Convert All’ button.

If the color is… PANTONE HexVector...

PANTONE Spot Color Uses PANTONE solid in hexachrome data to give exact Hexachrome
equivalent values for PANTONE MATCHING SYSTEM® Colors.

Non-PANTONE Spot Color The spot color is not converted to Hexachrome; all objects colored with
(meaning the ‘Color Type’ the spot color are not separated, but will remain in the output as additional 
has been defined as a Spot spot colors.
Color in Illustrator)

Spot colors not found in any As long as spot color names are not found in any PANTONE Color Library 
PANTONE Library or custom or custom library, they are maintained as non-separable spot colors. If you 
library (i.e., a PANTONE wish to convert these to Hexachrome, you need only change the ‘Color 
Metallic Color, a PANTONE Type’ from Spot to Process in the ‘Swatch Options’ window for that color.  
Pastel Color, colors from
another color system, etc.) Another option is to create an entry in a custom palette with that color’s 

exact name so that when you reopen any documents using that color, it
will now convert to a Hexachrome color using the ‘Convert All’ or ’Export 
As HexVector’ functions.

RGB Color/CMYK Color Uses ICC profiles selected in the HexVector Profiles window. Maps the 
(With ‘Match CMYK Colors RGB or CMYK data in the colors to the RGB or CMYK source profile,   
to Hexachrome’ selected in then remaps the data to the Hexachrome Separation profile to convert
the Profiles tab) the colors to Hexachrome color space.

CMYK color Performs a linear conversion to Hexachrome, which means that the
(Without ‘Match CMYK four-color CMYK values remain unchanged when converted to their 
Colors to Hexachrome’ Hexachrome CMYK counterparts (and PANTONE Hexachrome Orange 
selected in the Profiles tab) and PANTONE Hexachrome Green are set to zero).

Registration color Performs a linear conversion (see above) to Hexachrome, with solid
coverage in each color channel including any spot colors.  (All colors being
used in document.)

Grayscale color Converts to equivalent value in PANTONE Hexachrome Black.

Illustrator Colorized Black Separates to the selected Hexachrome or spot color values when you 
and White bitmapped 1-bit ‘Export As HexVector.’
images

One-color PANTONE When the RGB values are 0,0,0, (Black), the color will automatically map 
Hexachrome Black in RGB to 100% PANTONE Hexachrome Black.
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The Libraries Tab
This window gives you access to all three PANTONE Hexachrome libraries. The PANTONE
hexachrome coated and PANTONE hexachrome uncoated libraries are the digital version
of the PANTONE hexachrome guides. The PANTONE solid in hexachrome library is the
PANTONE MATCHING SYSTEM in Hexachrome. The PANTONE solid in hexachrome
library loads by default when Illustrator is launched.

Library dropdown list

This dropdown list enables you to choose colors to work with from the previously
mentioned PANTONE Libraries. Use the PANTONE Hexachrome libraries as you
would the PANTONE formula guide.  First find a color in any of the three printed
PANTONE Hexachrome Guides you’d like to use for an object. Then select the
corresponding color number from the correct library in HexVector. The use of the
printed guides is critical in determining how the colors will appear when printed,
as the representation of the colors on screen is only approximate.

Add To Palette button

This command allows you to make one or more color selections in a library and
add them with one click to the currently selected ‘Active Palette’ in the Mixer tab.
Multiple selections can be made using Shift-click or Command-click on the
Macintosh or Shift+click or Ctrl+click on Windows. 

Make Swatches button

This command adds selected colors to your Illustrator document swatch list on an
individual basis to be used on artwork immediately. Multiple selections can be
made using Shift-click or Command-click on the Macintosh or Shift+click or
Ctrl+click on Windows.
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The Palettes Tab
HexVector provides the ability to create and save custom palettes allowing you to manage
your Hexachrome colors and share palettes with other HexVector users. There are many
advantages to creating custom palettes, such as allowing you to store your most commonly
used Hexachrome colors without having to re-mix them and having instant access to a
palette from a previous jobs. The Palette tab is where you will create, save and use your own
custom color palettes.

Custom Palettes Dropdown list

This dropdown list allows you to select from all of your saved custom color
palettes.

New Palette button

Clicking this button brings up a dialog so that you can create and name a new
custom color palette.

Duplicate Palette button

This command will create a duplicate of the currently selected Custom palette in
its entirety. You will be presented with a dialog to name the newly created palette.

Delete Palette button

This button deletes the currently selected Custom palette. Select the palette you
wish to delete and click on the ‘Delete Palette’ button. After confirming that you
do want to delete the palette, it will be deleted from the ‘Custom Palettes’ folder
on your system.

19

Saved Custom

Palettes List 

Colors Saved

within the

Custom Palette

Create a New

Palette 



Make Swatches button

Clicking this button adds the entire contents of the currently selected Custom
palette to the Illustrator document swatch list at once.

Make Document Palette button

This is a powerful function that enables you to build a color palette based on all
assigned colors within an existing Illustrator document. Colors will be visible in 
the Mixer scroll list where you can modify them. When you click this button, you
will be presented with a dialog asking, ‘Do you want to re-map all document
colors to the new palette?’ Choosing to re-map all colors in the document allows
you to make document-level color changes by adjusting colors in the new
Hexachrome document palette and then clicking Convert All.

Answering ‘Yes’ is the equivalent of converting all colors to Global, and answering
‘No’ means you do not want to convert, which maintains the current definitions of
Local colors as Local and Global colors as Global.

In the first case, converting to Global, all colors in the entire document are
re-mapped to the newly created palette, allowing you to make document-level
color changes in one place: the Hexachrome document palette. 

In the second case, converting to Local, no colors in the document are changed
(i.e., we’re simply making a palette from colors in the document). 

For designers: Local changes allow you to make selective color changes to
localized objects defined with the same color.

For pre-press and printers: Global changes enable you to edit a single color
and re-color all objects throughout the artwork with one click. 

NOTE: For more detailed information on this function, please refer to the

Building a document palette section of this manual on page 25. 
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PANTONE HexVector Workflow

Setting Up Illustrator

If you are an experienced Illustrator user, then you probably have Illustrator settings selected
that are appropriate for the work you do. To take full advantage of Hexachrome and achieve
a far greater gamut than CMYK, we recommend that you maintain an RGB workflow. 

In Illustrator, it is very important to understand how to set up your "Color Settings" because
this will determine how your RGB file will be displayed and rendered. Red, Green and Blue
are individual channels, but the actual RGB colorants have no definition.  

The ‘Working Space" defines the color values of the image. Usually the "Working Space"
would be an RGB profile of your scanner, digital camera or your monitor. There are also
generic working spaces that are installed with graphic applications such as the Adobe
products, for example, sRGB, Adobe (1998), etc. Each color space varies in its color
definitions, so we suggest that you experiment to find the best working space for your
work flow.

Recommended ‘Color Settings’

1. Select your RGB and CMYK Working Spaces profiles. We suggest that you

start with the Adobe (1998) RGB profile (installed with Photoshop) if you are

not familiar with your RGB working spaces.’

2. Color Management Policies should always be set to ’Preserve Embedded

Profiles‘ for RGB and CMYK. This option allows you to work in a mix-color

managed and a non-color managed color space, keeping the integrity of the

RGB document.’  This setting must be used in order to embed the profile in

your HexVector document.

3. Check ‘Ask When Opening’ in all cases.’

4. Under ‘Conversion Options,’ the engine in Illustrator is ignored. HexVector uses

ColorSync on a Mac or ICM in Windows.’

5. The Rendering Intent should be set to Relative Colorimetric.

NOTE: These are recommended settings and we strongly suggest that you

review all settings to see what’s best for your workflow.
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Setting Up Your System

PANTONE HexVector, as a plug-in, cannot use Adobe’s conversion engine to perform color
transformations. Instead it uses ColorSync (Macintosh) or ICM 2.0 (Windows). Therefore, it is
critical that these components be set up properly. This section deals with setting up the
system correctly.

ColorSync Control Panel (Macintosh only) 

The ColorSync 3.0 control panel consists of two tabs, the Profiles tab and the
CMMs tab. The CMMs tab is what we are concerned with here.  

The ColorSync 3.0 CMMs tab

This control panel allows you to select the preferred CMM to use.
We recommend that this be set to Automatic. ICC profiles contain a tag
that will choose the appropriate CMM to be used with the particular
profile. This should insure optimum results. If you wish to use a different
CMM you can select it as appropriate.

ICM 2.0 (Windows only)

ICM works by allowing users to "associate" profiles with a particular device. This
association allows the profile to work with ICM to control color across devices. 

HexVector uses ICM to provide the image previews used during the separation
process. Thus, if you are using a monitor profile as your working space in
Illustrator, you should be sure that this profile is properly associated with Windows.
For more information, go to ‘Help’ on the ‘Start’ menu; click the Search tab and
type in ICM. Follow the instructions for associating monitor profiles.
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Hexachrome Colors

RGB and CMYK colors are converted to Hexachrome using the current profile setup on the
Profiles tab, and therefore the Hexachrome values for these colors may change when the
profile settings are changed. Grayscale colors are always converted to the equivalent level
of PANTONE Hexachrome Black and therefore do not change when profile settings
change. Hexachrome mixed colors are native Hexachrome colors and therefore do not
require conversion to Hexachrome. You can mix the CMYKOG values of these colors exactly
as you wish. The list of mixed colors in HexVector is shown in the scrollable list box at the
bottom of the Mixer tab, as well as the Palettes tab. This allows you to view the colors in
their active custom palette from either location.

Mixed colors can be created in one of three ways:

1. By using the Mixer to create your own Hexachrome colors:

a. Click on the ‘New Color’ button in the ‘Swatch Mixer.’ The sliders will be set
to zero. A default name for the new color will be entered in the text field
above. Change this name before clicking the ‘Add Color’ button.

b. Adjust the sliders of the Hexachrome base (CMYKOG) colors as desired or
type in specific numeric values. The ‘Add Color’ button will become enabled
when any ink value is greater than 0%.

c. Click on the ‘Add Color’ button. A new color will be created and added to the
list of mixed colors. Later, you can choose to add the color to the Illustrator
swatch palette using the ‘Make Swatch’ button. Once an object in Illustrator
has been defined with the color it will be recognized as a mixed color and
converted to Hexachrome when either ‘Export As HexVector...’ or ‘Print’
commands are selected.

2. Using the ‘Make Document Palette’ feature - On the Palettes tab, you will find
the ‘Make Document Palette’ button. When you click on this button, all colors,
regardless of their respective color spaces, are converted to their equivalent
Hexachrome color values (excluding ‘Color Type’ within Illustrator as spot colors).
All of these colors are then added to the mixed color list on the Mixer tab.  

3. PANTONE Hexachrome Colors - Colors can be added from the PANTONE
Hexachrome libraries palette. You can either add the color to the ‘Active Palette’
using the ‘Add To Palette’ button, or to the Illustrator document swatches palette
using the ‘Make Swatches’ button. A printed reference to these libraries can be
found in the PANTONE hexachrome guides and the PANTONE solid in
hexachrome coated guide.
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Converting an Existing Illustrator Document to Hexachrome

This section deals with the procedure to convert colors in an existing Illustrator document to
Hexachrome. To modify Hexachrome colors, you will need to build a document palette and
adjust the colors using the Mixer tab. 

NOTE:  PANTONE HexVector 2.0 cannot convert documents that were
created with earlier versions of HexVector.

To convert colors to Hexachrome

1. Launch Adobe Illustrator 9 and open the document you wish to convert.

2. From the Window menu, choose PANTONE HexVector, then Show HexVector
<tabname>.

3. On the PANTONE HexVector window, click the Profiles tab.

4. If your document is CMYK and you wish to apply a CMYK Source Profile,
check the ‘Match CMYK colors to Hexachrome’ box, and select the CMYK
source profile you wish to use.

5. If your document is RGB, choose the appropriate RGB source profile.

6. Select the Hexachrome separation profile.

7. Make sure that any user-created Illustrator swatch colors that you want to be
converted to Hexachrome have a color definition of CMYK or RGB and the
Color Type is ‘Process Color,’ not ’Spot Color.’

8. Click the ‘Convert All’ button. HexVector performs the following actions:

a. Tags all used colors in the Illustrator swatches palette for conversion to
Hexachrome, by mapping the colors first to the source profile, and then to
the Hexachrome separation profile.

b. Adds the converted colors to the Illustrator document swatch list. Local
colors ALREADY in the swatch list are converted to Hexachrome as long as
they’re used on an object, but if an object’s local color is not in the swatch
list HexVector won’t add it.  In other words, HexVector will only create
swatches for colors that already have a swatch in the Illustrator document
swatch list at the time of conversion. This will prevent the explosion of
swatches that occur when there are blends or a number of identical local
colors.

9. From the File menu, choose ‘Export As HexVector.’  The file is separated and
saved as a DCS2.0 file, that can be output from Illustrator or imported to a
page layout application such as QuarkXPress. The separated file may also be
saved as an Illustrator *.ai file.
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Building a document palette

In order to modify the Hexachrome color mixes contained in a document, you need to build
a document palette using the ‘Make Document Palette’ button on the Palettes tab. This will
create a color palette based on all assigned colors within an existing Illustrator document.
Colors will be visible in the Mixer color list and you can modify them.  

You have the ability to choose if these modifications are implemented globally, affecting all
objects defined with that color, or if local colors remain local and global colors remain global
after conversion.  

In simpler terms, you have the ability to easily create the new palette from the document
colors, leaving the document unchanged. Or you can have HexVector re-map all colors in
the document to the new palette. Document-level color changes can be made to re-mapped
colors by mixing new Hexachrome values in the Document Palette and then clicking
‘Convert All.’

The Document Palette contains only unique document colors. For example, several objects
may each be locally colored with their own identical shades of green, and several other
objects may be colored with a globally defined shade of green which is the exact same
shade as the locally defined shade of green used on the first objects. Changing the local
color definition of one of the objects will not affect the colors of any other objects in the
drawing. Changing the global definition of the shade of green will change the color of all
objects with that global color selected.  

Local and Global colors definitions are both powerful features, but each has trade-offs
for artist and pre-press technician alike. Selecting ‘Yes’ to remap all colors to Global will
combine all of the same colors and you will have one green in the HexVector Document
Palette. Selecting ‘No’ (‘No’ is the default function) to NOT remap all colors to global will
create a palette of all the colors in the document, but duplicate colors (such as identical
Local color definitions of the same color) are all combined into one color in the palette. 
Also, these combined colors will assume the name of the first Global color that HexVector
comes across. If no Global color is found, all duplicate colors will share the same default or
user-defined name for that color. 

Assuming you select ‘Yes’ or ‘No,’ HexVector will perform a ‘Convert All’ on the document,
and will extract all Hexachrome colors from the document, displaying them in the ‘Active
Palette’ color list on the Mixer tab. All duplicates of local colors will be deleted. The
document palette will be added to the palette list with the name you give it. You can then
modify any colors in the document using the Mixer tab (except PANTONE Library colors,
which cannot be modified).  

For designers:  Local changes allow you to make selective color changes to localized
objects defined with the same color. 

For pre-press and printers:  Global changes enable you to edit a single color and re-color
all objects throughout the artwork with one click.    
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Working with Custom Palettes

HexVector 2.0 allows you to create, name and save custom color palettes. These palettes
are saved inside the HexVector folder and can be shared with other users or with clients
that also have HexVector 2.0 installed on their system. In addition, these palettes are
cross-platform and can be shared between Macintosh and Windows users with HexVector
2.0 installed.

Creating a custom color palette

1. On the HexVector window, click the Palettes tab.

2. Click the ‘New Palette’ button or ‘Make Document Palette.’ A dialog box
will appear.

3. Type a name for your palette and click Save.  

4. The palette is saved with your assigned name and becomes an option
on the ‘Custom palettes’ dropdown list, as well as in the ‘Active Palette’
dropdown list on the Mixer tab.

5. You can now select colors from the PANTONE Hexachrome libraries or
create custom Hexachrome mixes and add them to your custom color palette.

Adding PANTONE Hexachrome Colors to a custom color palette

1. On the Mixer tab, select the custom palette from the ‘Active Palette’
dropdown list to which you want to add colors.

2. Click the Libraries tab.

3. Choose the appropriate PANTONE Library from the dropdown list.  Choices
are: ‘PANTONE® hexachrome coated,’ ‘PANTONE® hexachrome
uncoated,’ or ‘PANTONE® solid in hexachrome coated.’

4. Click on the color you wish to add.

5. Click the ‘Add To Palette’ button.

6. The color is added to the active custom color palette.

Adding multiple colors

1. Choose the appropriate PANTONE Library.

2. Click the first color you wish to add.

3. Press Shift-click or Command-click on the Macintosh or Shift+click or
Ctrl+click on Windows, and click each additional color that you wish to
add.

4. Click the ‘Add To Palette’ button.

5. All selected colors are added to the active custom color palette.
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Adding Mixed colors to a custom color palette

1. On the HexVector window, click the Mixer tab.

2. Choose the desired Custom Color palette from the ‘Active Palette’
dropdown list.

3. Click the ‘New Color’ button. A default color name is entered in the text box.
Type the desired name for the color.

4. Drag the CMYKOG sliders or type specific values for each Hexachrome
base color, until the desired color is achieved.

5. Click the ‘Add Color’ button. The color is added to your ‘Active Palette.’

Sharing Palettes

HexVector 2.0 allows custom color palettes to be shared with other users. This
enables you to collaborate and organize Hexachrome jobs more efficiently. The
small file size allows custom palettes to be easily sent along with a document or
sent separately for use in other artwork. The palette files are cross-platform
between Macintosh and Windows. Please note that all users sharing palettes
must have HexVector 2.0 installed in order to use these custom palettes. 

The palette files are stored in the ‘Custom Palettes’ folder. This is located in the
PANTONE HexVector folder that was installed into your Illustrator folder. To load
a custom palette that you have received, copy the palette file to this folder and
re-launch Illustrator. To send a custom palette, copy the appropriate file from this
folder.

NOTE: The system-level character sets differ between the Macintosh
and Windows platforms. Colors and palettes which are named using
uppercase-ASCII characters such as characters with diacritical marks
or European characters will not be displayed properly on the other
computer platform, so care should be taken to use only lowercase-
ASCII characters in naming colors and palettes.

Adding custom colors to the Illustrator Document Swatch List

Custom colors can be added to the Illustrator document swatch list either
individually, from the Mixer tab, or as a full palette from the Palettes tab.

Adding custom colors to Illustrator from the Mixer tab

1. Choose the desired palette from the ‘Active Palette’ dropdown list.

2. The colors display in the scroll box on the bottom of the Mixer tab.

3. Click the desired color to select it.

4. Click the ‘Make Swatch’ button. The color is added to the Illustrator
Swatches list.
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Adding colors to Illustrator from the Palettes tab

1. Click the Palettes tab.

2. Choose the appropriate palette from the ‘Custom palettes’ dropdown list.
The colors display in the scroll list at the bottom.

3. Click the ‘Make Swatches’ button. The entire palette is added to the
Illustrator swatch list.

Note: You CANNOT add individual swatches from the Palettes tab.

Printing and Saving Hexachrome Separations

Print

By default, the Adobe Illustrator Color Settings is set to ‘Emulate Adobe Illustrator 6.0.’ If
you intend to print your Hexachrome separations directly from Illustrator, we recommend
leaving this setting as the default. This essentially leaves color management turned off
which allows HexVector to correctly color manage the output.

However, if you do use an RGB color managed workflow and therefore change your Color
Settings, you must make the following adjustments if you are going to print Hexachrome
directly from Illustrator:

1. Select ‘Print’ from the ‘File’ menu.

2. Select ‘Adobe Illustrator 9.0’ from the popup menu.

3. Click the ‘Separation Setup’ button.

4. Make sure the ‘Convert to Process’ checkbox is UNCHECKED and make any
other adjustments according to your specific workflow. Click ‘OK’ to close this
window.

5. In the print dialog window, go to the ‘Print Space’ section and select any CMYK
profile from the Profile dropdown list. (This is due to a problem in Illustrator
whereby if you choose to print in the same color space as the source docu-
ment, in this case RGB, it will output a postscript file where all the colors are
defined as RGB colors and will be interpreted incorrectly by most RIPS and
postscript viewers).

6. You are now ready to print Hexachrome directly from Illustrator!

NOTE: The only way to output Hexachrome directly from Illustrator is to either leave

the ‘Color Settings’ set to the default ‘Emulate Adobe Illustrator 6.0’ OR to follow the

steps outlined above in a color managed workflow.

Print and Separation Setup only require that the document has either been converted or
saved as a HexVector file at least once. Afterward they will operate properly without needing
‘Convert All’ again.
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The HexVector Format

HexVector is not a file format in the usual sense but it is rather a manipulation of Illustrator
artwork to achieve the effect of using Hexachrome base colors only. For example, consider
an ellipse filled with RGB value of (0,50,255). 

The equivalent Hexachrome CMYKOG values of this color happen to be (79,59,0,0,0,0).
Internally, HexVector artwork is defined as six layers, each representing the six Hexachrome
separations in CMYKOG, superimposed on top of each other. Therefore, the above ellipse
example would appear as the following two superimposed ellipses. 

These are filled with the spot colors ‘PANTONE Hexachrome Cyan’ and ‘PANTONE
Hexachrome Magenta’ tinted with values of 79% and 59%, respectively. The ‘PANTONE
Hexachrome Green’ layer would also be present but blank because one layer has to
maintain the overprint characteristics for the object — the green layer serves this purpose
in HexVector. 

There is also a layer on the bottom that contains the last saved art. This layer is locked,
invisible and non-printing. There may also be one or more preview layers that are non-
printing as well. In rare circumstances when HexVector has had to clean up a corrupted file,
a layer called "Rescued Art" may also be present and visible. All these layers are
recombined when HexVector reopens a separated document, so all these layers are invisible
to you, the art appears ready for editing, and the process is as transparent and unobtrusive
as possible.

Workflow Hints and Tips: The only difference between ‘Convert All’ and
‘Export As HexVector’ is that the ‘Export As HexVector’ function exports the
separations themselves along with the artwork rather than just saving the
artwork which is the case with ‘Convert All.’
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Miscellaneous Functions

Different Types of Artwork

HexVector is capable of converting many different types of artwork including: blends,
gradients, simple paths, compound paths, text and black/white bitmapped 1-bit images.

Changing the Name of a Mixed Color

The name of a mixed color can be changed in the Illustrator swatch palette by double-
clicking the color and typing a new name in the ‘Swatch Options’ dialog.  However, the
revised name will NOT be reflected in the PANTONE HexVector custom palette. Therefore,
it is suggested that you utilize the ‘Make Document Palette’ function available on the
Palettes tab or create a new mixed color in the ‘Active Palette.’

NOTE: You will not be able to create a mixed color with the same name as
any of the PANTONE Library colors.

Holding a Spot Color

The expanded gamut of Hexachrome makes it possible to reduce the need to use spot
colors in your job. However, if you desire to do so, you can "flag" a spot color in your
document so that HexVector will not convert it to Hexachrome. This is handled by changing
the ‘Color Type’ of the color in the Illustrator swatch palette.  

The ‘Convert All’ feature works by searching the names of the colors. PANTONE Colors are
automatically tagged for conversion using the PANTONE solid in hexachrome data, whereas
custom colors are tagged for conversion using the profile setup, as covered previously. The
program looks for PANTONE Colors by name, looking for the word ‘PANTONE,’ followed by
one space, then the reference, e.g., PANTONE 185 C or PANTONE Warm Red CVU.    

To Preserve a Spot color

1. Locate the desired color in the Illustrator swatches palette.

2. Double-click the color to open the ‘Swatch Options’ dialog.

3. Change the ‘Color Type’ to Spot Color.

4. For PANTONE Colors, make a change to the name. For example, change
‘PANTONE 185 U’ to ‘SPOT PANTONE 185 U.’  

NOTE: PANTONE Spot Colors are not as necessary as they used to
be, as the Hexachrome library has exact specifications for most of
the colors as Hexachrome process colors. Step #4 is relevant only
if you specifically want a PANTONE Color with an equivalent in the
Hexachrome library to remain a spot color. Spot PANTONE Colors
not found in the PANTONE solid in hexachrome coated library will
remain spot colors.
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Custom Hexachrome Data

Roland color look-up tables and profiles

In addition to loading the above profiles, the installer will also create a ‘Disabled Libraries’
folder inside the PANTONE HexVector folder, in which the Roland large-format printer
libraries will be stored. These libraries provide the proper Hexachrome data that was specially
developed by Pantone to optimally represent PANTONE MATCHNG SYSTEM Colors on
Roland wide-format devices. When these libraries are properly loaded, HexVector will use
them in lieu of the default PANTONE solid in hexachrome data (which is for offset printing
presses), to provide the proper Hexachrome conversion for the Roland.

To use these libraries, you will need to do the following:

1. Inside your hard drive, open the PANTONE HexVector folder within the
Illustrator 9 folder.

2. Open the ‘Disabled Libraries’ folder.

3. Drag the PANTONE solid in hexachrome coated library to the ‘Disabled
Libraries’ folder.

4. Drag the desired Roland library to the HexVector folder.

5. If Illustrator was running, close it and re-launch it.

6. HexVector will now use the Roland data during the ‘Convert All,’ ‘Export as
HexVector’ or ‘Make Document Palette’ process.

Embedded Profiles and Illustrator

PANTONE HexVector gives you the option of embedding the source profiles (CMYK and
RGB) selected on the Profiles tab into HexVector documents so that the working space is
consistent and can be managed. This is also critical so that Illustrator can properly display
the proof layer.

If your Adobe Color Settings are set such that ‘Color Management Policies’ for RGB images
are set to Off, we cannot get the RGB working space from Photoshop.  So it is important to
set your ‘Color Management Policies’ to ‘Preserve Embedded Profiles.’

Therefore, it is recommended that when Illustrator complains of a profile mismatch, you
should choose to use the embedded profile. If the document has a profile embedded in it
that does not exist on the local machine, the new HexVector profiles will be stored after the
document is converted to Hexachrome using either ‘Convert All’ or ‘Export As HexVector.’ 

If you choose to embed profiles (the default), then the proofs and your working space
should always be accurate.

The only situation in which you should convert a document to the working CMYK or RGB
space is when you have chosen to turn off embedded profiles in the Profiles tab. In this
case, if you want the proof to look accurate, you need to make sure that your Illustrator
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default working RGB and CMYK space profiles are set up to match the document’s CMYK
and RGB profiles set in the HexVector Profile tab.

The choice to embed or not is saved on a document-by-document basis. Therefore, each
document can be set up individually regarding whether or not to embed a profile. 

Documents that are not HexVector documents (i.e., ‘Convert All’ or ‘Export As HexVector’
has never been used on the document) will NEVER have the RGB and CMYK profiles
embedded.
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PANTONE HexImage 2.0

New Menu Items

HexImage takes advantage of several of the Photoshop powerful plug-in features and
therefore the different features are accessed from different menus within Photoshop. To
begin, we will look at how to access the HexImage windows from within Photoshop.

a) ‘PANTONE® HexImage®’ from the Automate submenu in the File menu. This activates
the HexImage Separation Window where you can select your profiles, preview and create
your separations.

b) ‘Proof HexImage® Document’ from the Automate submenu in the File menu.  This builds
an RGB proof of the Hexachrome separation.

c) ‘PANTONE® HexImage® Color Correction’ from the Photoshop Filter menu. This activates
the Color Correction tool so that color changes can be made to the separated image.
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HexImage Functions and Dialogs

This section will provide a description of each of the functions and dialogs in HexImage,
including all buttons, dropdown lists and display areas. Later sections will describe workflow
issues relating to each function.

The Separation Window

This is the fundamental component of HexImage, allowing you to set profiles, preview and
separate your image for Hexachrome.

Source Profile

This dropdown list allows you to select a source profile to use with the image.
The source profile is a description of the color space of the image you want to
separate. HexImage will remap the image to this profile during the separation
process.  

Typically the "source" is a scanner or a monitor. The profile acts as a filter so that
the binary data in the image gets translated by the Color Management System
(CMS) into calibrated color data.

The source profile you select depends on the image you are going to separate. If
you want to reproduce the image as it looks on the monitor, you should use an
ICC profile for your monitor as the source profile. If the image has been scanned
and you have created a scanner profile, you should use that profile in order to
match the printed image to the original scan. 
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RGB Source Profiles

This lists the available RGB input device profiles (e.g., scanner and digital
cameras), as well as all monitor profiles available. On the Macintosh, it is
looking for the profiles in the ColorSync Profiles folder. For Windows 98/ME
systems, installed profiles are located in the Windows\System\Color folder on
and for Windows 2000 systems, installed profiles can be found in the
Windows\System32\spool\drivers\color folder.

CMYK Source Profiles

This lists the available CMYK device profiles. On the Macintosh, it is looking for
the profiles in the ColorSync Profiles folder. On Windows 98/ME computers,
profiles are installed in the Windows\System\Color folder. If you have Windows
2000 the installation location for profiles is the Windows\System32\spool\driv-
ers\color folder.

Embedded/Working Profiles

Use this choice if you are using an embedded profile as your RGB working
space or if you chose not to color manage your document. In this case,
HexImage will use your default RGB working space which is set in Photoshop
under ‘Color Settings.’

Separation Profile

This allows you to select a Hexachrome profile to use for the separation process.
The Hexachrome profile is a description of the color space of your output device.
During the separation, the image will remap from your source profile and then
separate to Hexachrome using this profile.

Separation profiles (also known as destination profiles) typically contain the color
characteristics of the output device.  Please refer to the description of profiles
found previously in the HexVector section of this manual.  Within HexImage, a
separation profile is a Hexachrome profile. The Hexachrome profile is used to
create a six-channel separation by accessing the calibrated color data that was
previously processed through the source profile. This data is then calibrated
through the Hexachrome profile which takes into consideration the printing
conditions, such as ink set, screening, dot gain, substrate and finish.
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The following profiles are installed on your system with HexWare:

Offset Lithographic Profiles

OffsetPositive Gloss Hvy
OffsetPositive Matte Hvy
OffsetNegative Coated Hvy
OffsetNegative Uncoated Hvy
CTP Coated Hvy
CTP Uncoated Hvy

Proofing Systems

Fuji Color Art Hvy
Imation Matchprint Hvy
Polaroid PolaProof Hvy
DuPont Waterproof CV Hvy
Kodak Approval XP-4 Hvy

Inkjet

Roland Hi-Fi JET PRO
Roland Hi-Fi JET
DuPontAX-4 Chromalin Hvy

Other

Flexo Narrow Web Lgt

A further description of the technical specifications for each of these profiles is
available in Appendix A.

Rendering Intent 

This selection allows you to choose from four different rendering intents which
will affect how your image is separated, especially in areas that fall outside the
color gamut of the destination color space, i.e., Hexachrome.  

Perceptual (Images) is the most commonly used rendering intent. It
emphasizes the preservation of the dynamic range of an image from highlights
to shadows. It is the best choice for most photographic imagery.

Saturation aims to create vivid color at the expense of accurate color. It
scales the source gamut to the destination gamut, but preserves relative
saturation instead of hue. Thus, when scaling to a smaller gamut, hues may
shift. This intent is suitable for business graphics, where exact color is not as
important as vivid, saturated color.

Absolute Colorimetric leaves colors that fall inside the destination gamut
unchanged. This intent aims to maintain color accuracy at the expense of pre-
serving relationships between colors. Thus, colors that are distinct in the source
gamut may be mapped to the same color in the smaller destination gamut.  
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Relative Colorimetric is identical to Absolute Colorimetric, with one important
difference. This intent compares the white point of the source gamut to that of
the destination gamut, and shifts all colors accordingly.  

Update Preview button

Anytime you make changes to your Profiles or Rendering Intent, you can click this
button to update the preview with your new selections.

Cursor Reading of Color Densities

You can move your cursor around the image preview to display the densities of
the six Hexachrome base colors that will be applied to that particular area of the
image. The densities are based on your Profiles and Rendering Intent selections.
These densities will change if you select a different Profile and/or Rendering
Intent and click the ‘Update Preview’ button.

Separate button 

Clicking this button performs the Hexachrome separation based on your
selections in this window.

Cancel button 

This allows you to cancel the operation and will immediately close the Separation
window.
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The PANTONE HexImage Color Correction Window

This window allows you to perform color corrections to your Hexachrome separated image
in the Hexachrome color space. As Photoshop itself does not support the Hexachrome color
space, this feature adds important functionality that allows you to make color adjustments to
the Hexachrome separation results.  Remember that an image must be separated into the
Hexachrome color space before using this filter.

This window performs a single color correction at a time, allowing you to see a preview of
the expected results before actually applying the color correction. You have control over the
color correction threshold, which affects how many colors near the selected color are
changed, and over the smoothness, which affects how abruptly colors near the selected
color are changed from their original values to the ‘After’ color selection.

Image Preview pane

When the HexImage Color Correction window first opens your Hexachrome
separated image, a small RGB preview is displayed. Moving your mouse cursor
over this image allows you to see in the Cursor Color pane the Hexachrome ink
percentages for a sub-sample of your image's pixels. Clicking the cursor sets that
color in the ‘Before’ color well.

Cursor Color pane

This pane includes indicators of the cursor's current Hexachrome color as both
ink percentages and as an RGB preview of the sub-sampled pixels color.

Colors pane

This pane controls the color correction operation itself. You set the initial color in
the ‘Before’ color well. The Hexachrome ink percentages for the color displayed
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below it. You may set the color either by clicking on a color in the preview image,
or you may use the Color Picker to select a color by clicking the ‘Before’ color
well itself.

In order to change this color, either click the --> arrow button, which copies the
‘Before’ color to the ‘After’ color well, then adjust the sliders, or simply adjust the
sliders to any value you wish. You may also select a color using the Color Picker
by clicking the ‘After’ color well.

The arrow buttons allow colors to copied from one color well to the other.  If you
wish to start your color change from a selection made in the preview, click the
arrow button which points from the ‘Before’ color well to the ‘After’ color well. If
you know the exact Hexachrome color mix you wish to change, you can enter it
with the sliders under the ‘After’ color well, click the arrow button pointing from the
‘After’ color well to the ‘Before’ color well, then make corrections to that color.

The Threshold and Smoothness sliders control the range of the color correction.
You can use these two sliders to affect the broadness and softness of the color
correction. A larger threshold setting increases the number of shades of color that
will be changed. A larger smoothness setting tapers the color changes near the
edges of the color corrected areas, thereby blending the changes more smoothly.
The exact setting for each of these sliders will depend upon the particular
application of color correction to your documents. Experiment with different values
to get a feel for the various types of effects that can be achieved.

The ‘Update Preview’ button redraws the preview image to reflect your settings.
No changes to your actual image occur until you click the ‘Apply’ button. You may
change any of the settings and update the preview at any time. Each time you
update the preview, the change is applied to the colors from the original
document.

For example, if you update the preview after making a change to lighten flesh
tones and you are not satisfied with the results, you can alter the settings as
necessary and click ‘Update Preview’ again. The second update will be applied to
the original skin tones, not the lightened skin tones. This way you may freely alter
the settings until you are happy with the preview and then click the ‘Apply’ button.

If you wish to resample the original document colors, hold down the Option key
(Macintosh) or the Alt key (Windows). The ‘Update Preview’ button should change
to ‘Reset Preview.’ Click the ‘Reset Preview’ button and the preview will be
restored to the original colors.

You may cancel the color correction at any time by clicking the Cancel button.
If you cancel, your image will be unchanged.
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You perform the actual color correction on your image by clicking the Apply
button. Note that you may get unanticipated results if you change the After color
or the Threshold or Smoothness controls after updating the preview. Remember
that HexImage performs its color correction using the Before and After colors and
the Threshold and Smoothness controls, and that it does not specifically make a
color correction to correspond to the preview as it is displayed. To minimize
unanticipated results, update the preview before clicking Apply.

Remember that you may undo your last color correction to your image using
the ‘Undo PANTONE HexImage Color Correction’ command in the Edit menu,
provided that you have not performed another operation since performing the
correction. You may also undo previous color corrections individually using the
History palette.

Using Color Correction Effectively

There are a couple of ways to use the color wells and the arrows. You can click
on either color well to bring up the color picker and choose a color. As the color
picker doesn't support Hexachrome color, the color you pick must be
translated into Hexachrome, and therefore may not be precisely the color you
chose, though it won't be much different.  This is due to the fact that the picker
uses RGB color space.

The two arrows allow you to copy a color from one color well to the other. This
can be useful in several situations, since only the ‘After’ color can be adjusted
using the Hexachrome color sliders. The following examples suggest several
possible uses of the color wells and arrows.

Normally you will pick up a color in the ‘Before’ color well by clicking with the
cursor over the desired color in the preview image. The ‘Before’ color will match
the color shown in the ‘Cursor Color’ swatch. Next you will click the right arrow to
copy the before color to the ‘After’ color, where you can make the desired
changes to the color using the Hexachrome sliders. If you know the exact
Hexachrome values of the ‘After’ color, you don't necessarily need to click the
right arrow; you can simply use the sliders to enter the values directly.

Perhaps you know the exact Hexachrome values of the ‘Before’ color, or you can't
seem to pick up the precise ‘Before’ color using the cursor. Here is where the left
arrow comes in handy. If you know the exact Hexachrome values of the ‘Before’
color, use the sliders to enter the values directly and then click the left arrow to
copy the color to the ‘Before’ well. 

If you have picked up a Hexachrome color with the cursor and the color is close
but not exactly the correct color, first click the right arrow to copy the color to the
‘After’ color well. Make any changes to the color with the sliders, and then click
the left arrow to copy the color back to the ‘Before’ color well. You can now make
changes to the ‘After’ color using the sliders.
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Color Correction Tips

The two other color control sliders on the Color Correction dialog, ‘Threshold’ and
‘Smoothness’, control the range of the color correction. Once you have chosen
‘Before’ and ‘After’ colors, you can use these two sliders to affect the broadness
and softness of the color correction. We recommend first setting the smoothness
slider to a value of one. This will allow you to clearly see how broad your color
correction will be. Gradually increase the ‘Threshold’ slider setting, clicking the
‘Update Preview’ button between changes, until all of the shades of the color you
have selected change.

Once you are satisfied that all of the desired shades are changing, gradually
increase the ‘Smoothness’ slider setting, clicking the ‘Update Preview’ button
between changes, until the shades near the edges of the color corrected areas
blend smoothly into the rest of the image. Since ‘Smoothness’ tapers the changes
near the edges of the color corrected areas, you may need to increase the
‘Threshold’ a little after reaching the desired ‘Smoothness.’
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PANTONE HexImage Workflow

This section deals with the process of setting up Photoshop and your system to work
with HexImage, as well as describing the workflow of using HexImage in a production
environment.

Setting Up Photoshop

If you are an experienced Photoshop user, then you probably have Photoshop settings
selected that are appropriate for the work you do. To take full advantage of Hexachrome
and achieve a far greater gamut than CMYK, Pantone recommends that you maintain an
RGB workflow. 

In Photoshop 6.0, it is very important to understand how to set up your ‘Color Settings’
because this will determine how your RGB file will be displayed and rendered. Red, Green
and Blue are individual channels, but the actual RGB primaries have no definition.  

The ‘Working Space" defines the color values of the image. Usually the "Working Space"
would be an RGB profile of your scanner, digital camera or your monitor. There are also
generic working spaces that are installed with graphic applications such as the Adobe
products, for example, sRGB, Adobe (1998), etc. Each color space varies in its color
definitions so we suggest that you experiment to find the best working space for your
workflow. If you are unsure which source profile to select, a good RGB profile to start with
is Adobe (1998), which is installed with Photoshop.

Recommended ‘Color Settings’

1. Select your RGB, CMYK, Gray and Spot Working Spaces profiles.

2. Color Management Policies should be set to ’Preserve Embedded Profile‘
for RGB, CMYK and Gray. This option allows you work in a mix-color
managed and non-color managed color space, keeping the integrity of the
RGB document.

3. Check ’Ask When Opening‘ in all cases.

4. Under ‘Conversion Options,’ HexImage ignores the engine that is selected
in Photoshop as it is looking to ColorSync on a Macintosh or ICM on
Windows.

5. The Rendering Intent should be set to Perceptual.

NOTE: These are recommended settings to get you started and we
suggest that you review all settings to see what’s best for your workflow.

If your Adobe Color Settings are set such that ’Color Management Policies‘ for
RGB images are set to Off, we cannot get the RGB working space from
Photoshop, so it is important to set your ’Color Management Policies’ to ’Preserve
Embedded Profiles.’
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Setting Up Your System

PANTONE HexImage, as a plug-in, cannot use Adobe’s conversion engine to perform color
transformations. Instead it uses ColorSync (on the Macintosh) or ICM (on Windows).
Therefore, it is critical that these systems be set up properly. This section deals with setting
up the system correctly.

ColorSync Control Panel (Macintosh only) 

The ColorSync 3.0 control panel consists of two tabs, the Profiles tab and the
CMMs tab. The CMMs tab is what we are concerned with here.  

The ColorSync 3.0 CMMs tab

This control panel allows you to select the preferred CMM to use.  We
recommend that this be set to Automatic. ICC profiles contain a tag that will
choose the appropriate CMM to be used with the particular profile. This should
ensure optimum results. If you wish to use a different CMM, you can select it
as appropriate.

ICM 2.0 (Windows only)

ICM 2.0 works by allowing users to "associate" profiles with a particular device.
This association allows the profile to work with ICM to control color across
devices. 

HexImage uses ICM to provide the image previews used during the separation
process. Thus, if you are using a monitor profile as your working space in
Photoshop, you should be sure that this profile is properly associated with
Windows.  

For more information, go to ‘Help’ on the ‘Start’ menu; click the ‘Search’ tab and
type in ICM. Follow the instructions for associating monitor profiles.
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Separating Images

Embedded Profiles

If your image has an embedded profile, and this profile is different than the working space
that you have set in Photoshop’s color settings, you will be presented with three options, as
outlined below.

1. Use the embedded profile (instead of the working space) – Displays colors
based on the embedded profile.  

2. Convert document’s colors to the working space – Maps the embedded profile
into the working space you have defined in the Photoshop color settings and
embeds the working space in the document.

3. Discard the embedded profile (Don’t color manage) – Discards the embedded
profile and embeds nothing in its place. The colors are controlled entirely by the
working space in Photoshop.

We recommend using the embedded profile as your working color space. This will help to
maintain the color’s original intent. You may also convert to your default working space, but
you should be aware that some clipping might occur if your default space is smaller than
your embedded profile.

Separate

After you have made your selections, you can click on the ‘Separate’ button. A new multi-
channel document will be created that contains the six-channel Hexachrome separation. 

Photoshop does not automatically create a composite view of multi-channel files as it
does for CMYK separations. Images that are separated with HexImage use the spot color
function in Photoshop where the color information in each channel is specified to create a
composite image. Each of the six Hexachrome channels is colored with the Pantone
specified L*a*b* values, based on the printing method specified in the Separation profile
pop-up menu. See Appendix B for these specific values. 

To disable one or more of the channels in the preview, simply deselect the eye icon in
the Channels palette. Even if the values that are put into the channels by default are the
standard Hexachrome L*a*b* values, Photoshop will interpret these in different ways depending
on how you have configured the RGB, CMYK and Spot Color setups in Photoshop. What
this means is that even if the theoretically correct values are used to create the colors in the
preview, it still may not appear on screen exactly how it is going to print on the press.
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Proof HexImage Document
This feature is accessed by going to the Automate submenu in the Photoshop File menu.
It allows you to construct an RGB soft proof of your Hexachrome separated image.
HexImage does this by remapping the Hexachrome colors in the separated image back
through your RGB working space to your monitor profile for display. As the color gamuts of
RGB and Hexachrome are somewhat similar, the proof should closely resemble your RGB
original unless you have made color corrections to the Hexachrome separation prior to con-
structing the proof. The RGB profile that was used to make the proof will be embedded into
the proof document itself.

NOTE: The Proof Document function can serve many purposes, for example,
after you have finished making color corrections and generated a proof, the
RGB proof can be saved for use on the Internet or for printing in CMYK. You
can also back up the RGB proof for future use.

RGB Workflow NOTE: The RGB source and separation profiles are embedded
into the Hexachrome separated document so that when you generate a Proof
Document as described above, the proof will match the original color space.
Embedding this profile also provides the added benefit of being able to proof
the Hexachrome document on any machine maintaining the original working
color space (even machines that don’t have the original separation profile
installed).

CMYK Workflow NOTE: The CMYK source profile of the original image is NOT
embedded into the Hexachrome document due to the fact that the proof is to
be rendered in RGB, meaning a CMYK profile cannot be used. Therefore, in
the case of a CMYK workflow, the RGB default working space that is selected
in your Photoshop Color Settings preferences will be embedded as the source
profile, in order to enable HexImage to render an accurate proof. If you intend
to proof the Hexachrome document on another machine (that contains a
different RGB default working space setting in Photoshop) it will still use the
original machine’s RGB default working space, as it’s embedded in the
Hexachrome document.

L*a*b* Workflow NOTE: In the case of an L*a*b* workflow, there will be NO
source profile embedded. Instead, when generating the proof, HexImage will
use the default Photoshop L*a*b* space. This is due in part to the fact that
there is no default L*a*b* working space selection in Photoshop, as L*a*b* is the
largest color space available, encompassing the gamuts of both RGB and
CMYK.
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Working with HexImage Color Correction

As stated previously, Photoshop does not support the Hexachrome color space.  However,
the PANTONE HexImage Color Correction window allows you to perform global or localized
color corrections in Hexachrome color space, while previewing the image in RGB. As the
Hexachrome and RGB gamuts are so comparable in size, the RGB preview of Hexachrome
is highly accurate.  

To use PANTONE HexImage Color Correction:

1. Separate your image for Hexachrome as directed.

2. From the Filter menu, choose HexImage, then PANTONE HexImage Color
Correction. The Color Correction window opens.

3. Using the cursor, select a color in the preview image that you would like to
adjust. The color appears in the ‘Before’ color well, with the CMYKOG values
displayed.

4. Click the right-pointing arrow between the ‘Before’ and ‘After’ color wells.  The
color duplicates in the ‘After’ color well.

5. Clicking on the ‘Before’ or ‘After’ color wells will open the Color Picker window,
which allows you to create custom colors or select from the PANTONE Libraries.

6. Make the desired adjustments to the values and click the ‘Update Preview’
button. The preview alters to reflect your changes.

7. Make any desired adjustments to ‘Threshold’ and ‘Smoothness.’

8. When all changes have been made and the preview is to your satisfaction, click
‘Apply.’  The color corrections are applied to your DCS2.0 separated file.
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The PANTONE HexImage Color Correction tool can be used with the Photoshop powerful
image editing tools. For more information, see the ‘Workflow Hints and Tips’ section of this
manual.

NOTE: All color corrections are stored in the Photoshop History palette.
Further, color corrections are scriptable, allowing for automated batch

processing.

Saving and Replaying Color Corrections

Use of the PANTONE HexImage Color Correction Tool can be recorded using the
Photoshop Actions function. Corrections can be applied to one or more images in an auto-
mated method.

Saving your color corrections

1. Open a saved file, which has been separated using PANTONE HexImage, or
separate a new image.

2. On the Photoshop Actions palette, use the arrow on the upper right-hand
corner and select ‘New Action.’

3. Type a name for your action and set a ‘hot’ key, if desired. The name of your
action will display in the ‘Actions’ palette.

4. Click the ‘Start Recording’ button on the ‘Actions’ palette control bar.

5. Open the PANTONE HexImage Color Correction tool and perform your
correction. Photoshop will record each step in the correction process.

6. When you have finished your correction, click the ‘Stop Recording’ button on
the ‘Actions’ palette control bar.

Playing back your color corrections

1. Open the separated image file.

2. Locate your saved correction on the ‘Actions’ palette and click to select it.

3. Click the ‘Play’ button.

4. Your correction is automatically applied.
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Proofing Your Separations on the Monitor

PANTONE HexImage allows you to generate a proof on the monitor. Of course, this will be
an RGB proof; however, given the relative similarity of color gamuts, there should be little to
no data lost during this process.

To generate a proof of the separation

1. Separate your image using HexImage.

2. Select the separated file.

3. From the File menu, choose Automate, then ‘Proof HexImage® Document.’

4. The RGB proof will be generated on your monitor.

The proof should be quite similar to the original, unless color corrections were made to the
separated file prior to proofing.

Saving Hexachrome Separations

Multi-channel files can be saved in primarily two different ways: as Photoshop documents
and as DCS2.0 files. DCS2.0 files can be placed in all major layout and design applications
such as Adobe Illustrator, QuarkXPress, Adobe PageMaker, Adobe InDesign® and others. 

DCS2.0 files can be saved in different ways, either as a single file or multiple files. Multi-file
DCS2.0 files create one black and white image for every color separation and a low resolution
file that is placed in the layout application or used to open the image in Photoshop. For
Hexachrome separations, it is most convenient to save single files, as this will save only one
file instead of seven files (the preview plus six black and white separations) for multi-file
DCS2.0 files. The file size and RIP time is the same for both versions of DCS2.0 files. Use
the Save As selection from the File menu in Photoshop to save as a DCS2.0 file.

Batch Processing

HexImage can be set up to run in batch mode, utilizing the ‘Actions’ palette as follows:

1. From the ‘Actions’ palette, choose ‘New Set.’

2. Give your new set a name.

3. Create a new action within the set.

4. Record your entire separation process, including saving the separated file and
closing the original.

5. From the ‘File’ menu, choose ‘Automate,’ then ‘Batch.’

6. In the ‘Batch’ window, choose the set, action, source folder and destination
folder that Photoshop is to use to process your files.

7. Click ‘OK." Batch processing will begin.
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NOTE: Keep in mind there exists the possibility that you may try to
batch separate a group of documents with different color modes or
with and without embedded profiles. In this case the following rules
apply:

1. If you’ve chosen to batch separate using embedded profiles,
documents with embedded profiles will use them; documents
without embedded profiles will use the "default" profile for the
document type (e.g., the last profile you used to separate a
document of that type).

2. For all batch separations, embedded profiles or not, if you’ve
never separated a document of a certain type (e.g., you’ve never
separated an L*a*b* image before with HexImage, so you’ve never
selected an L*a*b* profile). If HexImage can’t find the profile you
most recently used, that particular file will be skipped in the
batch and separations will continue on the rest of the files.

For more details about the batch function, refer to ‘Using the Batch command (Photoshop)’
on Page 405 of the Photoshop 6 User Guide.

Comparing Four-color Output to Hexachrome in Photoshop

You can easily see a comparison between the potential CMYK and Hexachrome output by
using the built-in CMYK preview function in Photoshop for the source RGB, CMYK or L*a*b*
image. The CMYK preview will show you the image as it will be printed in CMYK, based on
the settings that you have selected in the CMYK Setup within Photoshop. The image will,
however, still be in RGB mode so no information is lost.

1. Open the source RGB or L*a*b* image in Photoshop.

2. Separate the image using HexImage and then generate a proof by utilizing the
‘Make Proof Document’ function.

3. Select View->Proof Setup->Working CMYK.

4. Select View->Proof Colors.

5. Now both images are displayed.
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Enabling QuarkXPress 4.0 for Hexachrome Output

QuarkXPress 4.0 supports Hexachrome design and output.  However, it must be setup
properly to separate and print Hexachrome correctly. The Quark CMS extension must be
loaded and color management turned on. This extension, and Hexachrome support, is
included in the base Quark package, but is often turned off by users. 

You may select any Hexachrome profile. When printing, the separations checkbox must be
checked to create separations. Before printing, check the output tab in the print dialog to
make sure only six channels will print. If there are other channels listed to print, check the
color list to see what other colors are in use. There is no way to print composite files from
Quark, as Hexachrome is a separated workflow.

Now you can place your pre-separated DCS2.0 image that was generated by HexImage or
your HexVector artwork from Illustrator into QuarkXPress the same way you normally place
CMYK EPS images/artwork. In QuarkXPress, the six Hexachrome base colors are not
displayed in the color palette by default; you don't need to have them there in order to print
Hexachrome separations. The base colors can, however, easily be selected in the Edit Color
window under the ‘Multi-Ink’ color model. 

To mix your own Hexachrome colors in Quark, select the ‘Multi-Ink’ color model, and then
select ‘Hexachrome’ under ‘Process Inks.’ Select one Hexachrome color in the list, select
‘Shade’ and proceed to any value in list or select ‘Other’ and type in your own values. It is
best to always add PANTONE Hexachrome Black because the ‘normal’ QuarkXPress black
is separated into a rich CMYK black. The Hexachrome color libraries built into QuarkXPress
can also be used to color text and vector objects and are available in the color model
pop-up menu.

NOTE: When outputting Hexachrome separations from QuarkXPress, it is
important that you color all black type with PANTONE Hexachrome Black;
otherwise it will be built up as a CMYK build.

NOTE: When placing Hexachrome separated images into QuarkXPress, the
Hexachrome base colors do not get automatically added to the color palette.
They do not need to be there in order to print Hexachrome separations. It is
only if you want to color objects in QuarkXPress with the Hexachrome base
colors that you need them in the palette. They can easily be added from
the PANTONE Hexachrome Coated or PANTONE Hexachrome Uncoated
libraries available in the color Model menu under Edit Color.
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Workflow Hints and Tips

PANTONE HexImage allows you to take advantage of several powerful Photoshop features.
Several of these are outlined in this section.

Using the History brush

You can apply a correction to a small area of the image, and brush it into desired
areas of the image without affecting the entire file. Use the following steps:

1. Separate your image.

2. Open the PANTONE Color Correction tool.

3. Make your correction and apply it to the image.

4. On the History palette, click the arrow in the upper right-hand corner and
select ‘New Snapshot.’

5. In the ‘New Snapshot’ box, type a name for your snapshot, if desired, and
click ‘OK.’  The snapshot appears in your History palette.

6. Undo the correction in your separated image.

7. In the History palette, select the snapshot with the ‘History Brush’ icon.

8. Choose the ‘History Brush’ tool from the main Photoshop toolbar.

9. Adjust brush settings. All standard Photoshop brush settings are available,
including mode, opacity, etc.

10. Brush in your correction to the separated image. Only the brushed areas
are affected.

Localized Color Correction using Selection Tools

You now have the ability to use a selection tool to isolate a portion of the file for
color correction. This is particularly useful with large files to dramatically shorten
the time to apply the correction.

1. Separate your image using PANTONE HexImage.

2. Using the selection tool of your choice, e.g., Lasso tool, scrolling marquee,
brush, etc., isolate an area of the image.

3. Open the PANTONE Color Correction tool.

4. The preview displays only the selected area of the image. 
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Hexachrome Color Spectrum 

The Hexachrome Color Correction window may be opened with the Hexachrome
color spectrum color picker instead of a preview of your Hexachrome separated
image. To do so, hold down the ‘Control,’ ‘Option,’ and ‘Command’ keys
(Macintosh) or ‘Shift,’ ‘Alt’ and ‘Ctrl’ keys (Windows) simultaneously while selecting
the ‘PANTONE® HexImage® Color Correction’ command in the HexImage
submenu of the Filters menu.

The color picker rotates through the full gamut of Hexachrome color mixes when
you move your mouse cursor across the preview window horizontally. The vertical
dimension adds increasing amounts of black to the mix.
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Frequently Asked Questions
Below are some of the common questions that we receive from professionals working in
Hexachrome and those that have been working specifically with HexWare. If you have any
questions, which are not answered below, please refer to the current FAQs on our Web site,
www.askpantone.com, or register there and submit your inquiry directly to our technical
support department. Registering enables you to save your questions and allows you to login
and review them at any time. As an alternative, you may submit a standard E-mail message
to support@pantone.com.

Question

What does CMYKOG stand for?

Answer

The six base colors that make up the PANTONE Hexachrome Color System: PANTONE
Hexachrome Cyan, PANTONE Hexachrome Magenta, PANTONE Hexachrome Yellow,
PANTONE Hexachrome Black, PANTONE Hexachrome Orange and PANTONE
Hexachrome Green.

Question

What screen angles should I use when printing Hexachrome separations from Illustrator?

Answer

Illustrator does not set the screen angles automatically, so you will need to specify these
as follows:

PANTONE Hexachrome Cyan: 15°
PANTONE Hexachrome Magenta: 75°
PANTONE Hexachrome Yellow: 90°
PANTONE Hexachrome Black: 45°
PANTONE Hexachrome Orange: 15°
PANTONE Hexachrome Green: 75°

Question

When placing a HexVector file in QuarkXPress 4.0, the Hexachrome color names do not
appear in the color palette. What am I doing wrong?

Answer

You are not doing anything wrong. This is the way QuarkXPress 4.0 handles Hexachrome
separations. The files will output correctly but the color names will not appear in the color
palette as they did in earlier versions of QuarkXPress. In order to output Hexachrome
separations from QuarkXPress 4.0, you need to install the Quark CMS Xtension. 
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Question

The printing company I am working with does not have HexVector. Can they use the
HexVector files I create?

Answer

Yes, HexVector files can be opened in Illustrator for output but without HexVector, changes
will not be possible. The document will consist of a saved art layer that will not be printed.
The Hexachrome separations are stacked in the layers you used when creating the artwork.

Question

I have a document that was previously created with CMYK colors. What should I do to utilize
all six Hexachrome color inks when I convert the colors using HexVector?

Answer

Be sure that the "Match CMYK colors to Hexachrome" checkbox is checked before clicking
the Convert All button. Unlike the 1.0 version of HexImage, no workarounds are needed to
convert CMYK to CMYKOG.

Question

How much memory should I allocate to Illustrator now that I have installed HexVector?

Answer

Be generous in allocating memory to Illustrator.  Due to the replication of artwork, memory
requirements can increase considerably.

Question

How do I separate a file into Hexachrome plus one or more spot colors?

Answer

You may preserve a spot color by doing the following:

1. Locate the desired color in the Illustrator swatch palette.

2. Double-click the color to open the ‘Swatch Options’ dialog.

3. Change the color definition to Spot Color.

4. For PANTONE Colors, make a change to the name. For example, change

‘PANTONE 185 U’ to something like ‘SPOT PANTONE 185 U.’

Question

I have an Illustrator file with a mix of CMYK and PANTONE Colors. How do I convert these
all into Hexachrome?

Answer

Simply click on the ‘Convert All’ button in HexVector. All spot colors with names that match
PANTONE Library color names are separated to Hexachrome. Save the file as a HexVector
EPS and/or print it directly from Illustrator.
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Question

When I click the ‘Convert All’ button, the colors (PANTONE, RGB and/or CMYK) on my
screen change appearance. Why does this happen?

Answer

HexVector is using the Source profile set in the Profiles tab to create a color match from the
Hexachrome mix to the monitor color space. If the monitor profile is correct for your
particular monitor, the on-screen preview will be accurate for Hexachrome colors that fall
within the color space of the monitor. Sometimes orange colors tend to appear redder than
the printed version because RGB monitors typically do not have enough color fidelity to
display clean orange colors accurately.

The ‘Make Proof’ button on the ‘Profiles’ tab can be used to provide an accurate preview of
the converted file. Please refer to the HexVector Make Proof section of this manual for a
more detailed explanation.

Question

How do I change the name of a previously created Hexachrome mix?

Answer

Select the color in the Illustrator Swatch palette and choose ‘Swatch Options...’ from the
pop-up menu on the Swatches palette.

Question

When I save a HexVector EPS file, a dialog box asks me which type of EPS Format to use.
What settings should I use here?

Answer

Make the EPS file compatible with Illustrator 9.0. Check the CMYK PostScript option and
select PostScript level 2. The preview setting can be selected to whatever you want.

Question

Which Separation profile should I use when working with HexImage?

Answer

This depends on how the image is going to be printed. If it is going to be printed in offset in
the United States, the printer most likely will use negative film to create the plates. If the job
is going to be printed in Europe, the printer most likely uses positive film to create the plates.
The separation profiles are also created for either coated (glossy) or uncoated paper.

Question

When I try to save my Hexachrome separations, I am not able to save it as a Photoshop
EPS or Scitex CT, as well as several other formats. Why does this happen?

Answer

Hexachrome files are multi-channel files which are not compatible with several formats, such
as Photoshop EPS, Photoshop PDF, JPEG and Scitex. Instead you should save the image
either as a Photoshop DCS2.0 file or as a native Photoshop file.
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Question

How much memory should I allocate to Photoshop now that I have installed HexImage?

Answer

Be generous in allocating memory to Photoshop. As a guideline, it is recommended that on
the Macintosh you allocate memory equal to three times the image size plus the base
Photoshop memory requirements. It is also important to leave a few megabytes of system
memory free outside of Photoshop otherwise making the Photoshop partition too large will
ultimately cause HexImage to fail. Windows handles the memory independently.

Question

When I print Hexachrome images from Photoshop, the screen angle is 45 degrees for all
channels. How do I get the correct screen angles?

Answer

Choose File->Page Setup... and click on Screens in the dialog box for Photoshop-specific
settings. De-select the Default and set the following angles:

PANTONE Hexachrome Cyan: 15°
PANTONE Hexachrome Magenta: 75°
PANTONE Hexachrome Yellow: 90°
PANTONE Hexachrome Black: 45°
PANTONE Hexachrome Orange: 15°
PANTONE Hexachrome Green: 75°

Question

In which applications can I work with my Hexachrome separations after I use HexImage and
save them as Photoshop DCS2.0 files?

Answer

QuarkXPress 3.32 or later, Adobe PageMaker 6.0 or later, Adobe Illustrator 9.0 or later and
Macromedia® FreeHand® 7.0 or later.

Question

Can HexImage be used to separate images into CMYK?

Answer

No, HexImage will only separate files into Hexachrome.

Question

Which Rendering Intent should I use when I separate images?

Answer

The Perceptual rendering intent is best suited for photographic images, while Relative
Colorimetric is better to use when separating artificially created images with a lot of bright
and chromatic colors.
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Question

How do I print a composite Hexachrome file to my printer/RIP?

Answer

This is not possible with the design and layout applications that we use today. In the future,
when PostScript 3 is implemented fully within the applications, composite Hexachrome
documents will become a reality. Until then, Hexachrome documents need to be printed as
separations directly from the design/layout application.

Question

When I separate images, any path that I have in the image gets deleted in the separation.
What should I do to preserve the path?

Answer

Paths are not preserved when separating through HexImage, so you will have to drag the
path to the new Hexachrome document.
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Technical Support
Pantone is committed to offering you immediate and polite technical support. Technical sup-
port is provided at no charge to registered users of our products. Please be sure to provide
a concise description of your problem including your system specifics.

You can reach Pantone Technical Support several ways:

1) Telephone: 201-935-5500, Monday through Friday, 8:00 a.m. to 6:00 p.m.,
Eastern Time

2) Fax: 201-896-0242. Make sure you indicate whether you want a reply by tele-
phone, fax or E-mail. Don’t forget to include your telephone, fax number or E-
mail address.

3) E-mail: support@pantone.com

You may also visit our online knowledgebase at www.askpantone.com. Here, you can search
through our Frequently Asked Questions (FAQs) or submit your questions directly to
Pantone Technical Support. You may also register which enables you to save your questions
and allows you to login at any time to review them.

How to Contact Us
NORTH AMERICA

Pantone, Inc.

590 Commerce Boulevard

Carlstadt, NJ 07072-3098

Telephone: 201-935-5500

Fax: 201-896-0242

E-mail: info@pantone.com
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ASIA

Pantone Asia, Inc.

10/F., Communications Building

55 Hennessy Road

Wanchai, Hong Kong S.A.R., China

Telephone: (852) 2724-8822

Fax: (852) 2724-8800

E-mail: sales@pantone.hk

D/A/CH AND EASTERN EUROPE

Pantone, Inc.

Representative Office of Pantone, Inc.

Roonstrasse 23a

D-76137 Karlsruhe, Germany

TEL: 49-721-82037-37

FAX: 49-721-82037-38

E-mail: info@pantone.de

EUROPE

Pantone U.K., Inc.

8 Stade Street

Hythe, Kent CT21 6BD

England

Telephone: 0044 (0) 1303 269666

Fax: 0044 (0) 1303 264464

mailto:support@pantone.com


Appendix A
Profile Descriptions
The Hexachrome profiles that ship with HexWare 2.0 are standard ICC profiles that can be
used with any applications that use ColorSync or ICM 2.0 and support six-color profiles.
HexWare includes profiles for standard printing conditions, as well as profiles for
Hexachrome-approved devices as shown in the list of installed profiles.

NAME SUBSTRATE TAC FINISH LINE SCREEN

OffsetPositive Gloss Hvy Magnostar 350% Gloss 175

OffsetPositive Matte Hvy Magnomatte 350% Matte 175

OffsetNegative Coated Hvy Lustro 350% Gloss 175

OffsetNegative Uncoated Hvy Astrolite 260% NONE 175

CTP Coated Hvy Lustro 350% Aqueous 175

CTP Unoated Hvy Astrolite 260% NONE 175

Dupont A-x4 Chromalin Hvy Dupont Stock 350% Gloss Inkjet

Dupont Waterproof CV Hvy Lustro 350% Gloss 175

Fuji Color Art Hvy Lustro 350% Gloss 175

Imation Matchprint Hvy Lustro 350% Gloss 175

Kodak Approval X-P4 Hvy Lustro 350% Semi Gloss 175

Polaroid PolaProof Hvy Lustro 350% Semi Gloss 175

Roland Hi-Fi JET POM-PETG- Special Gloss Inkjet

Roland Hi-Fi JET PRO 6652 Special Gloss InkJet

Flexo Narrow Web Lgt.icc 60# cast-coated 320% Gloss 200

Special thanks to L.A. Label of Commerce, CA for giving us permission to use the Flexo profile.

You will notice that all profiles that ship with HexWare 2.0 end with the Hvy code.  This is to
indicate that these profiles use Heavy GCR.  GCR stands for Gray Component Replacement
and defines how gray and dark colors are reproduced. They can either be reproduced with
CMY and a smaller amount of black, in this case Medium GCR, or with a higher percentage
of black, resulting in Heavy GCR. The printed result will be the same for both profiles, but
the way black and dark colors are created is different. HexWare 2.0 contains a base set of
profiles and they were all created using Heavy GCR. You can access the Medium and Light
GCR equivalents on our Web site at www.pantone.com. We suggest that you experiment
and separate with each type of profile to determine which black generation you like best in
your environment. 
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Pantone partners with the leading developers of profiling software in order to create
Hexachrome profiles. Hexachrome output profiles can be created or modified with the
following tools available from Pantone-licensed developers:

• GretagMacbeth – ProfileMaker Pro version 4.0  www.gretagmacbeth.com

• ITEC – Colorblind Professional www.itec.net

• Monaco Systems  – MonacoPROFILER Pro 3.x  www.monacosys.com

For further information on the creation of profiles and issues pertaining to color
management, please visit the Web sites listed below.

www.adobe.com

www.agfa.com

www.apple.com

www.colorsync.com

www.fujifilm.com

www.gretagmacbeth.com

www.imation.com

www.heidelberg.com

www.quark.com

www.rolanddga.com

Windows-specific color information:

www.microsoft.com/hwdev/DEVDES/ICMWP.HTM
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Appendix B
PANTONE Hexachrome Standard Values
These measurements are to be used as guidelines for printing in Instrument: X-Rite 938 Spectrophotometer
Hexachrome.  Different instruments give different measurements Geometry: 0/45
and have to be taken into consideration when comparing these Illuminant: D50
measurements.  For a visual color representation of the Hexachrome Observer: 2°
base colors, please refer to the PANTONE hexachrome guides Density: Status T.Absolute measurement
and/or the PANTONE solid in hexachrome coated guide.

PANTONE Hexachrome Yellow

CIELAB XYZ Density (Dry readings)

L* 91.8 X 75.1 C 0.05

a* -4.6 Y 80.2 M 0.12

b* 92.8 Z 8.3 Y 0.95

C* 93.0

h 92.9

PANTONE Hexachrome Orange

CIELAB XYZ Density (Dry readings)

L* 69.2 X 56.0 C 0.08
a* 50.3 Y 39.5 M 0.85
b* 84.9 Z 2.5 Y 1.45

C* 98.7
h 59.4

PANTONE Hexachrome Magenta

CIELAB XYZ Density (Dry readings)

L* 51.8 X 39.9 C 0.20
a* 80.5 Y 19.9 M 1.52
b* -9.3 Z 20.7 Y 0.64

C* 81.1
h 353.4
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PANTONE Hexachrome Cyan

CIELAB XYZ Density (Dry readings)

L* 52.0 X 13.0 C 1.65
a* -35.5 Y 20.1 M 0.48
b* -53.0 Z 50.8 Y 0.22

C* 64.3
h 235.5

PANTONE Hexachrome Green

CIELAB XYZ Density (Dry readings)

L* 61.1 X 12.9 C 1.40
a* -76.5 Y 29.3 M 0.33
b* 33.2 Z 10.2 Y 0.85

C* 83.4
h 156.5

PANTONE Hexachrome Black

CIELAB XYZ Density (Dry readings)

L* 13.4 X 1.6 Visual: 1.80
a* 0.1 Y 1.6
b* 0.4 Z 1.3

C* 0.5
h 82.2
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